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1. Activation
Upon starting HDR projects 5 professional for the first time, you
will be prompted to activate the program. Proceed as follows:

Install HDR projects 5 professional as described by the installation
instructions.

Input your serial number. For the box version, this can be found on
the accompanying booklet. If you have chosen to download the
program, you will have received the serial number by email directly
following your purchase.

16 days remaining.
e

Serial Number: |

Please enter your serial number and dick "Activate”,

[ Activate now | [ Later

Finally, click on the “Activate” button. The software has now been
successfully activated!

Note: HDR projects 5 professional can be installed on up to two
computers using the same serial number.

A second serial number is not necessary. When installing the
program on a second device, simply enter the serial number again
and press “Activate”.



2. Fascinating  High Dynamic  Range
Photography

Even the most modern digital cameras have a limited dynamic
range. Drastic lighting contrasts exhibit this restriction easily, such as
with a photo taken indoors looking outside, like in the first example
shot. You either have a properly lit interior, where the surrounding
park behind the arches are far too bright, or an image with an
adequately lit park, but with an interior that is far too dark.

HDR technology, short for High Dynamic Range, clears up this
problem by generating images with an extremely large dynamic
range, unmatchable by monitor displays or prints.

The idea is simple - several images with varying exposure times are
assembled into one image. In our example, three shots are fused: an
image with a longer exposure time to capture the dark details inside
the pavilion, a short exposure shot where the park behind the
pavilion is correctly lit, as well as an exposure exactly in the middle.

The combined result is a single image containing all of the light,
midtone and shadow detail. HDR projects 5 professional does the
work for you.

The capable program merges the bracketing exposure images and
uses tone mapping to establish a photo fit for printing and screen
displays.
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The combined image contains all of the details of the pavilion and park,
properly lit just as we saw the scene with our own eyes.

In the next few pages we will show you how quickly you can create
fascinating images with HDR projects 5 professional and what you
can achieve with its immense range of functions.

An obvious case for HDR projects 5 professional - an evening scene
with lanterns can only be captured naturally using HDR technology.
Otherwise, the dark surroundings would not be capturable with the
bright lights. A camera sensor's range of contrast is very limited
when compared to that of the human eye.
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All of the details are realistically depicted in the fused photo.

Tip: Always capture your bracketing series with different exposure
times, not just with different blending values. Merging the images
requires an identical depth of focus for all of the individual shots.



3. What’s new?

HDR projects 5 professional offers many new features. Here is an
overview of some of the most important developments:

v" New filter Plug-ins for Adobe® Photoshop (all versions from
PS CS6 to CC 2015.5)

v" With 21 new presets HDR projects 5 professional now has a
total of 155 presets. On top of that there is a preset browser
for all presets

v" There are now two new HDR Algorithms: “Repro neutral”
and “Repro intensive”

v You can load up to 55 pictures per bracketing series

(previous versions could do a maximum of 33 photos) for
perfect high dynamic range images

v The program has been extended with two new tone
mapping procedures “contrast” and “brilliance”

v" The interface design has been completely revised and now
supports work with 4K monitors

v One can now choose the font sizes for menus and titles

v A hot key list as well as a list of unloadable camera RAW
formats were embedded in the program
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v' The GPS coordinates of a photo allow you to directly see
where the photo was shot in Open-Streetmaps

v" A user-driven HDR algorithm-profile including import &
export gateway has been integrated into the program

v" New as well is the automatic HDR optimizing contrast
range

v There is support for eight extra colour spaces (D65)

v" An automatic brilliance optimisation carried out by RAW
image files

v" An interactive automatic optimisation was added to the
ghosting removal.

v The RAW-module has also several new functions:

Category “FX" with 8 extra effects

Light diffraction correction in the area of colours

dynamic brightness
Trapezoid distortion
Colour dynamic

v HDR projects 5 professional has got a new renaming
module in batch processing
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v" New: comparison of function in the preset browser What"s
really practical: the optimisation assistant with different
choices of opacity

v The absolutely novelty in HDR: film grain-module with
adjustable I1SO number, six different film grain forms,
masking the film grain and fractal film grain

v" many new effects and functions you can find in the
selective drawing

Increasing contrast

Reducing contrast

Blending in the original image

Mask production in optional brightness/colour
Smoothing brush

Soft-focus effect, reduction, increase on masks

optional mask colour

automatic adaption of masks from selective drawings onto
the distortioncorrection in RAW - module

v" Composing modus with free downloadable pictures in four
levels in the selective drawing
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HDR projects 5 professional has now 16 new post-processing
effects:

Dissolving Optimisation of the
structure

Mist & fog reduction Logarithmic gradation of the
colour channel

Denoising optimisation Colour correction

Colour dynamic Warp

Film grain- analog Light glow

Film grain - fractal Lens reflection
Logarithmic gradation Water reflexion
Optimising the focus

Restoring the highlights

v' Extra: 56 course pre-settings for the selective processing
all post-processing effects

v" Imagetapering with 71 style sheets and new tools to help
like the golden spiral, the golden cut and the the third rule
over helplines

v' Optimising the HDR engine as well as the post-processing
engine.

v"Increase in speed to two factors and more

10




4. Configuring the user - interface
Optional font size for Menus and titles

In the main menu of the program you will find in View -> font size an
option to customise the size of the letters in the menu as well as in
the titles of the programm.

4 HDR projects 5 professional (64-bit) (TRIAL) - V5.52.02653

File Edit View Extras Add-ons Information

FRANZIS [\5 @ Information windows Ctrl+I

Exif information window Ctrl+E
s

P Histogram Ctrl+H

R 2

z'"y Full screen view on/off Ctrl+F

*®_ Interface style... (dark grey) »

Font size > Small menus and topics

® Frame colour: grey card -> automatic e Sl

Large menus and topics

 Restore window defaults

The font size can be adjusted to the run time of the program. 4K -
monitors gives you the option to enlarge the font size for better
readability of the menu.
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5. HDR Photos Done Quickly

You can obtain a finished HDR image in just 5 clicks with HDR
projects 5 professional.

1. Load Images

2. HDR Preparation

3. Post-Processing -> Preset Selection
4. Optimisation Assistant

5. Select Image segment and Save, that s it!

You can simply drag and drop your images or bracketing series
onto the start screen

How to get the results you want, and fast - the elaborated presets
and looks, individual image adaption and selected drawing allows
you to go down your own creative route. HDR projects 5
professional offers both options.
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6. Importing image material
To load a single image or a bracketing series, simply drag and drop
the images onto the start screen. Alternatively, you can also use the
toolbar buttons or drop-down file menu.

The maximum number of possible exposures of a bracketing series
is 55 pictures in HDR projects 5 professional.

How does this number come about?

A HDR- photograph (High Dynamic Range) differentiates from other
photographs through one major characteristic:

The information of 32 exposure levels (32 Bit/ 32 ev) can be saved in
one image.

These 32 exposure levels (32 Bit/32 ev) are made up of the accuracy
of RAW images with 14 exposure levels (14 Bit/ 14 ev) as well as the
exposure differences throughout the bracketing series.

Let’s take for example a bracketing series that was taken with -2ev,
Oev, and +2ev. Which has as a result the dynamic range of +2-(-2) = 4
ev as exposure difference. This plus the 14 exposure levels from
RAW, has a total of 18 ev exposure levels (18 Bit/18ev).

The 55 images can exactly replicate a bracketing series from -9 ev to
+9 ev with intervals of 1/3 ev between two images. This ensures that
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you have used the maximum exposure that you can get out of a very
good camera.

The HDR preparation dialog will open as soon as an image or a
bracketing series has been selected or dragged and dropped into the
program.

Here you can choose if you want to see the dialog each time you
upload a bracketing series (click on the box at the bottom).

[ Colour space conversion B Noise suppression

Adobe RG

[ white balance

B Exposure optimisation

Halogen light go

Fluorescent light
Morning/evening sun

ZJ Alignment

fast normal exac maximum

[ Automatic ghosting correction

v Life forms

RAW options




> Bracketing series browser

For a better overview of your bracketing series you can use the
bracketing series browser before uploading your bracketing series.

Click on the corresponding symbol in the task bar. A preview window
will open. Chose by ,quell folder” your bracketing series folder.

¥ DSC_3101_2_3_4_5_NEAT projects_tiff

‘ ¥ DSC_3101_NEAT projects_2_NEAT projects___5_NEAT projects_tiff

L)

HDR projects 5 professional starts immediately with the
calculation, fitting automatically the right images together as well as
showing a preview image. If you go across the image with the
mouse, the image will automatically enlarge itself.

The file type-filter is practical here, since one often has jpg rows
and RAW images together in one folder. But if you type in RAW in the
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file type, only the RAW rows will be shown. You won’t have any
doubles any more.

At 100% the search for images is finished.

From this point on you will be able to upload the desired bracketing
series. Click on the desired row with a right mouse click and chose in
the context menu “open as project”.

¥ psc_3101

ey

FEE Open as a project

rfrr Deactivate exposure brack|

E_I.’,‘( Delete exposure bracketin,

HDR projects 5 professional uploads the images of the desired row
and just like the simple Drag &Drop of the images on the desktop we
start now with HDR preparation.
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7. HDR- Preparation

Here you can precisely configure the program'’s settings.

For the first steps, please use the standard settings. These default
settings can be restored with the arrow at the bottom left. Nothing
can be irretrievably adjusted.

DR preparation

[ Colour space conversion [ nNoise suppression
v

A G

[ white balance E

y afternoon sun

RAW options
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Colour space conversion: R —
advanced users can choose a
colour space here - for all other
users, it is recommended to not
make any adjustments, to avoid
incorrect colour rendering later.
HDR projects 5 professional
offers several new colour spaces
(D65). The standard illuminant
D65 is representative for a
phase of natural daylight with
the colour temperature of 6500°
Kelvin.

White balance: corrects colour casts that occur with shots
taken, for example, in a warmly lit room. To start, leave this
setting unchanged.

With this regulator one can adjust the colour temperature
when you “re already uploading. It is advised that you leave
the setting on “default” and to regulate the colour
temperature later in post-processing.

RAW-options: The automatic brilliance optimisation for
RAW files can be activated in image preperation under RAW
options. Frequently it is with camera RAW formats that the
image data will not use all tonal values that are available.
The automatic brilliance optimisation compensates this with
the uploaded RAW images by amplifying the tonal values so
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that a meaningful utilised histogram is created for every
camera RAW image.

RAW options

¥ Automatic luminocity optimisation

B Automatic rotation

In the area for bracketing series this option is only wise, if
you create HDR images from a single RAW.

Denoise: these buttons allow you to select the precision of
the noise removal, and the slider regulates the degree of
the sharpness for the edges. Here dark images can undergo
significant noise removal and have hot pixels (light spots
caused by the camera’s sensor in dark situations)
eliminated.

Exposure optimisation: can be chosen if an image in a
bracketing series is improperly lit and/or blurry, and must
therefore be supplemented by the program. With a dark
bracketing series, it is recommended to use the “Optimise
dark areas” function to remove any colour casts. Light areas
and details can also be optimised for bright bracketing
series.

Alignment: here you can influence how the individual
images of the series are congruently positioned on top of
one another. The subtlest movement of an object,
unintentional zooming or rotating of the camera can be
considered. In the majority of cases, the default settings
often lead to the preferred result.

19
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h. Automatic ghosting correction: HDR projects 5
professional uses a highly precise ghosting removal to filter
out subjects and people moving within the bracketing
series. Without correction the people or vehicles in the final
image would appear half transparent several times and
create a complete jumble.

Fusing the images without ghosting removal. People are always
on the move in a busy train station! Without correction,
ghosting always occurs with multiples exposures

The detailed process illustrates a special procedure. It attempts to
predict movement within the bracketing in order to remove the
ghosting more accurately. New in version 4 are the intelligent
settings for life forms, landscape, architecture and sports. The “Life
forms” corrector is perfect here.
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8. Post-Processing: Presets
Just like in the last version of HDR projects professional we shall start
after the uploading of images directly in post-processing. Here we

control the tone mapping of the images, before editing the results
with filters and effects.

Left side of the post-processing screen:
the presets show the breakdown of the
live preview in categories - “All”, “Natural”,
“Landscape”, “Monochrome”, “Colour
fidelity”, “Custom”, “Surreal”,
“"Architecture”, “Artistic”, and "Glow" with
the quantity of presets in the appropriate
category.

To begin, we've chosen the “Natural
balanced” preset. Clicking on the preview
image applies the effect to the image in
real time, which will then be displayed in
the middle of the screen. Discover the
wide variety of different looks by clicking
on the 155 different presets. You will be
amazed by the intriguing styles in the
artistic section!

Image with “Natural balanced” preset

Image after applying the “Landscape
Colour and Detail” preset.
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All 155 HDR projects 5 professional presets at a single glance. The
bar “pre-settings” you can detach easily and adjust to the desired
size.
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[]
+ preview Gatlery [ = I

Would you like to see all the previews for the loaded image or series?
Open up the category “all” and then subsequently click on the
symbol.

HDR projects 5 professional constructs then a browser gallery with all the
presets. For a larger display click on the picture.

This very practical feature is reminiscent of good old contact sheets.
You can create proofs to assess how the image with your favourite
presets would look when printed.

> Preset browser: ﬁ

The variation browser allows you to choose from different versions
of a function and is primarily operated with the mouse:

shifting the segment: hold down the left mouse button, before
moving the mouse
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zooming in: scroll up

zooming out: scroll down

choosing the variant: double left click on the image
setting a referent: left click on the image

comparison with referent: hold down the right mouse button over
the image

The corresponding short cuts you can find under “information ->
short cuts”.

¥ ‘
)
o =2

8 .

-

i

" .
NN

Lo

=

—
!

~

Y
55

7

\

=
|

) .

I
> -

=
.'l!
b

e
3

gt Lok faro ks |

[ S

e e
S

—

E

T
‘b
STt T

Click on the symbol and HDR projects 5 professional will show you
the entire preview gallery of that chosen category. Zoom in now on
the variant that you want to compare and set a reference image.
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This reference image you will be able to put on any image through a
left click of the mouse. You can fade in this reference image into the
other image by holding down the right mouse button.

The border surrounding the image in a green dashed line shows you
the reference image so that you can make the comparison. In this
way you can compare any two variants in the browser directly and
visually.

Example: As a reference image you choose the variant “landscape
brilliant” and mark the image with a left mouse click. The green
dashed line shows that you have chosen this image.

Now you look for a different preview image, in this case Preset
landscape bicolor 1 has been chosen.
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Right click on the preset landscape bicolor 1 and the reference
preset will fade in. As soon as you let go of the mouse button, you
will see the Bicolor 1 Preset again. This is how you simply and
purposefully compare looks with another before choosing the ones
you like the best.

Selection of your desired variation:

With a double click you chose the variant. The relevant program
settings will be carried out automatically.

Tip:

Your current choice will, when you open the window, be
automatically set as your reference image.

> Combine presets

To merge two looks together use the “Combine default presets"
button directly under the categories. These new presets will be
saved under "Custom". It's that easy to expand your numerous
options and accumulate new ideas!

> Name Favourites

Have you found certain
presets that you love and
instantly want to have handy?
oot @ St Click on the top right star in

- o filter - the preset window and add
the setting to your favourites.
By clicking the button, previews all of your favourite presets will be
displayed

w Favourites: 3
- - -
== 0+m
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Landscape backlit

Do you want a comparison to the HDR image without tone mapping?
Simply right click on the middle of the image to see the before/after
result. A quick check on the editing process is available at any time.
For an extensive overview with selectable areas and luminance
display, click on the symbol bar.

> "



> Preview mode

When this option is activated, the result image will appear as a small
preview size. If this option is deactivated, the picture will appear in
its true size. Please note that processing the preview can take longer
when this feature is deactivated.

> Real Time Processing O

When activated, all of the changes that you have made to the preset
settings will be immediately applied to the image and you will see
the outcome of your adjustments directly.

If this option is deactivated, then you will only see the outcome of
your adjustments when you click the button “calculate E

afresh”.

» High-Quality Display m

Activate this option to see the preview image in high-resolution. If
the preview is set at 100%, there will be no difference. If you zoom in
on a section of the photo however, there is a noticeable difference in
quality.



» Border Pixel Display

The border pixel display helps to reveal areas that tend towards
maximal light and dark values that is to white and black. Dark border
pixels are depicted by blue and light pixels by orange.

Depiction of border pixels in dark blue and orange tones

If you would want to brighten this image, you have to be careful of
the orange border pixels. Light surfaces on the car and the walls
should not become too white, in order to avoid losing detail. In
technical terms, these patches are called “burned highlights”. The
border pixel view helps to find these critical image areas.

» Symbol ,original resolution setting” E

With this pushbutton you will set the zoom factor on the original
resolution.
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> "Increase the Zoom factor to screen size”

With this symbol you will enlarge the zoom factor to the maximum possible
screen size.

> Import/Export from Presets

Presets from earlier versions can be easily imported. Do you want to
exchange all of your presets with a friend or just secure all of your
treasures? Use the practical export function.

> Filter Presets

Locating presets can be difficult when you have imported presets or
created many additional looks. For example, enter “filter" into the
search bar and only presets relating to “filter” will be shown, for
example “red filter”, “gradient filter” or “polarising filter”. This makes
the search a lot easier.
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9. Post-Processing: Finalisation
Now that we have understood the
most important part of post-
$ Magnifying ¢ 3ss processing, lets go onto fine-
s tuning, which can be found on the
> Bl Foni fiterest = right side of the screen under
“Finalise". These features are
intended to only to be used to edit
pictures further after selecting a
preset.

finalise

HDR algorithms

ultrs

= HDR BIHDR

» The magnifying glass

On the right hand side (at the very top) in Post-processing you will
find the 1:1 magnifying glass. The magnifying glass shows you the
area under the mouse in a 1:1 pixel view.
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To keep the magnifying glass on a specific point, press down on the
“L" key, while you move the mouse over the screen.

’
'
’
’
’
v
’
’
'
’
’
’
'
’
v
’
’

Click into the image area of the magnifying glass, to change between
the display modus “divided before/after comparison” and “direct
before/after comparison”.

To free the fixated area of the magnifying glass, press down on the
“L" key once more.

Point of interest

> Point of Interest L#s3 H Point of interest =)

Activated “Point of Interest” renders the current editing only to a
specially defined area of the image. The effects will be applied in
their full form, however only visible in the specified spots, the rest of
the image will be left unaffected. This effect is intended for very
large, high-resolution photos, for example panorama pictures.

» HDR/Ultra HDR

This technology describes the art of fusion of bracketing series
images. Ultra HDR processes up to 30 intermediate images between
two photos with 64-bit precision. The result speaks for itself, and
clearly shows a more detailed picture, especially in difficult
situations, for example when shooting directly against the light.

32



The strength of Ultra HDR can be seen in sensitive situations:
the sunlight in the image on the right is significantly more
detailed and less overexposed.

This highly precise calculation system can be applied to specific
types of motives: daylight, landscape, twilight, architecture, interior,
night-time and mixed light.

These settings can be accessed in post-processing at any time

Scenario

-
e’ ) Daylight

» Scenarios

Additionally, the HDR fusions can be influenced by different
scenarios. If you would like to adjust your result to a certain lighting,
select one of the following seven scenarios: “Daylight”, “Landscape”,
“Twilight”, “Architecture”, “Interior”, “Night-time" and “Mixed Light".
The scenario option has an overview of all of the possibilities that
can be directly applied with just one click.

» HDR-Algorithms

Here a mathematical equation is used to determine the weighting of
each individual exposure in a series - pixel for pixel. Every algorithm
has a different effect depending on the bracketing and subject.
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There is no right or wrong here, rather your originality is in
command. Test your bracketing series with different algorithms and
see how they affect your photos.

Tip: The HDR algorithm “Entropy”, in most cases, will yield a finely
tuned and detailed result in all tone values.

> Intelligent Colour Space (SCA Processing)

Intelligent colour space {SCA method)

Colour median (balanced)

This menu offers you options for optimal colour detail gradation of
your tone mapping results. Selecting SCA processing (Smart
Colourspace Adaptation) demonstrates differences in the details of
more saturated colours.

Tip: With “Supersampling” you will get exceptional details and
saturated colours!

» Tone Mapping Light Effect

Light effect of the tone mapping

Daylight Twilight Night

Detail protection 0

Adjust your image to whichever time of day you prefer. By applying
“Night”, the image will be brightened, to adjust the light accordingly.
The control allows you to protect certain details and regulate the
daylight, dawn or night settings further.
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» Optimisation assistant

Optimisation assistant

Optimisation: natural

==

The optimisation assistant is a

very efficient tool for fast,
fascinating results. When the
preset is activated, denoising,

tonal value, clarity, dynamic
and sharpness settings can all be
adjusted by sliding the control to
the left or right. The result can be

seen live. The optimisation
assistant is intelligent; it
remembers the values you

entered, and applies the same
settings to the next image in the
same way, but tuning the result to
the new motif.

Optimisation assistant

-
==$ Optimisation: natural

> Optimisation on Optimisation off

100 %

{;a' Denoising

P Tonal value

q  Carity

“== Dynamic

If you would like to edit without the assistant, you can simply turn it
off. If you would like to turn off the values that have been “learned”

so far, click on the

Additionally, the assistant can be
given optimising specifications
for an entire image style: choose
between natural, brilliant, fine,
soft, intense, sober colours, high
key and low key.

Optimisation assistant
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» The opacity regulator of the optimisation assistant

Optimisation assistant

- - -
e Optimisation: natural

(56 Optimisation on Optimisation off

- =
e | Denoising

The opacity regulator in
the optimisation assistant
activates itself
automatically as soon as
one optimisation is
activated. The opacity
regulator works on every
effect that optimises the
image as well as the
optimising presettings.

Tip: Put the optimisation presetting in “High-Key” and chose an

opacity regulator between 40-60%.

Pro Tip: Remember that the preset specifications and Optimisation
Assistant are added together. If you select the “Surreal powerful
colours" preset and the “Intense” optimisation, you will get strong,
saturated colours and dramatic contrast. Not to worry, you can
quickly change back to the “Natural” optimisation and have the
familiar look of the “Surreal powerful colours" again. On the other
hand, you can compile new creative ideas and jump between
intense, unsaturated and high and low key looks lightning fast.
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> Granulation module

a. Natural grain

Film grzio

In natural grain the different ® 8 Natural grain ]
Ievels. of photographic paper ® H + 4 O s
are simulated, which creates
a natural irregularity.

These following parameters
are therefore at your
disposal:

> Form

(96 E #, Fractal grain

ISO 200

Choose here from six
different variants.

Quality 50 Yo

» ISO-number
The preset value conforms to the average “restless value” on a
naturally grey surface.

> Size
The maximum size of a simulated grain.

» Masking
Gives you the opportunity to calculate the granulation in all different
types of daylight or alternatively in light, shade or shade and light.
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Film grain

Here the Masking has only been set for the lights. This way they
receive a natural granulation, while at the same time the sky is
spared.

A Click on the button creates a new random
distribution of grain and therefore a whole new look.

b. Fractal grain

Film grain Fractal grain simulates a large scale

b il Natural grain irregularity, which is created through
the storing and deterioration of
photo  material. Therefor the
following parameters are at your
disposal:

#5) #, Fractal grain

> 1SO-number

The preset value conforms to the average “restless value” of a
naturally grey surface.
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» Quality

Determines the accuracy of the calculation (number of iterations for
the fractal algorithm) of the fractal granulation.

In the granulation module there is no singular best setting, since the
ideal grain size, form and quality is 100% dependant on the motif.
Here you can try out different things and find new creative paths.

A Click on the button creates a new random distribution of
grain and therefore a whole new look.

> Removal of Scratch and Sensor Errors

Corrections

Erase scratches/sensor errors &

Micro-contrast enhancement wused in HDR photography
unfortunately shows every unwanted sensor imperfection that every
photographer, despite internal camera sensor cleaning, knows and
dreads. Don't stress - just eliminate them! With the easy to apply
correction function from HDR projects 5 professional, it can even
be fun.

Pro Tip: This intelligent correction doesn't only remove sensor spots,
but other disturbing things too - a deserted beach has never been so
easy to produce.

Lightly mark defects in your motif, the program will automatically
substitute these areas with other appropriate parts of the image.
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The sensor spots are circled in red

Here’s how to go about correcting:

AsE S

Correction areas (0/200)

e B-

Selected area
Hed Be

+

Select the brush tool under (6) and click on
the point of the image that you would like to
correct. A circle will appear beside it that will
serve as a source.

Move this circle to a place on the image that
can act as a source for the first marking. The
selected area will then be improved based
on the source.

Prior to this, you can reveal sensor spots,
which will appear as a bright patch in the
image, with (1).

(2) allows you to expose or hide the fixed
areas. Even when the corrections are still
active, even if they have been blended in.
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Hiding is solely to enable a before and after comparison.

You can select multiple areas to correct by simply clicking on the
brush symbol (6) and adding another point.

The button marked (3) can blend the targeted corrections in and out,
which also controls clarity.

(5) deletes the added corrections.

The section marked (7) controls the size of the area that is to be
corrected.

You also have the option to automatically search for the best source
area for the improvement. Click on the (8) button.

Button (4) calculates the appropriate correction spots for all of the
points automatically set using (8).

All currently selected corrections can be deleted with the (9) button.

The sensor spot corrector marks all of the patches and determines a
source within the image that can be used as a substitute.
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HDR Projects 5 professional - user manual

Successful sensor spot correction.

> Post-Processing Expert Mode

The Post-Processing expert mode

can be found on the right side of
the screen. Here you can configure all postprocessing, try new
effects, adjust a selected preset or construct a completely new
preset to meet your desires.

Overview of the Tools:

a) Tone Mapping Algorithms

b) Post-Processing Effects

¢) Selected Tone Mapping and Effects

d) Settings for Selected Effects
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> a) Types of Tone Mapping
(13)

Tone mapping algorithms compromise
the dynamic range of images with
strong contrast down to a presentable
range and serve to improve the quality
of the image. HDR projects 5
professional offers 11 different
algorithm options that can be applied
individually or combined.

Simply double click on the entry to add
the tone mapping to your selected
filter.

All  tone  mapping works by
compressing the local tone values and
contains an integrated detail enhancer
for macro and micro details.

Tone Mapping Contrast (new):
Contrast Tone Mapping creates well
defined shadows and lights and is
suitable for landscape and architecture
photographs.

Tone Mapping Brilliance (new):
Brilliance Tone Mapping creates a soft
luminosity in the shot and is suitable
for broad palettes in motifs.

4 Tone mapping (13)
A e nent tone mapping
gradient tone mapping
mapping
nt tone ma

4 Post-processing filter (97/97)

EE BN E

Colour detail strengthener

Effects you have selected (3/3)

% B Tone mapping contrast
“ B hted bla
v . Jalance local contrast

(i gree panorama mode

Tone mapping contrast
E.: normal L 2 =
e I E]
EE WL

p low In

50
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Tone Mapping Colour Fidelity:

The newly developed colour fidelity processing works with maximum
precision for colours in tone compression and is exceptionally suited
to shots with intense colours.

Tone Mapping Gradient:
The tone mapping gradient algorithm has a substantial effect and is
well suited to subjects with weak colours and high contrast.

Tone Mapping Gradient Luminance:
This process is a modified version of the gradient process, and
especially enhances lighter areas.

Tone Mapping Contrast Gradient:
This option yields best results for subjects with mainly middle
colours.

Tone Mapping Middle Values:
Tone mapping middle values is a very stable process and suitable for
almost every subject.

Tone Mapping Middle Value Exponents:
This effect is stable and works best for dark areas. It is especially well
suited to tunnel and archway shots.

Tone Mapping Middle Value Gradient:

This process was specially optimised for dark bracketing. Dark areas
will be significantly lightened even with slight intensity (tone
compression).

Tone Mapping Quotient:
This is a general tone mapping process that neutralises a colour
saturated image, when compared to the effect of a gradient process.
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Tone Mapping Sigmoid:
The sigmoid function is specialised for scaling brightness of motives
with drastic highlights.

Tone Mapping Surreal:
A very intense feature and therefore a good basis for extreme HDR
images.

Tone Mapping Intense:

Intense tone mapping works with a high bandwidth of tone
compression and therefore can be very effective for both dark and
light bracketing series.

> POSt-PrOCESSlng EffeCtS 4 Post-processing filter (97/97)

47 EE BN Em E
The list includes 97 different post-
processing effects that can be freely
applied and combined.

Colour detail strengthener

The effects are divided into six
categories, each with a
corresponding background colour.

Yellow: border effects

Sharpen - fine

Green: geometric effects
Turquoise: exposure effects
Blue: colour effects

Purple: diffusing effects

Pink: artistic effects
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Tip: If you are looking for a certain effect and know its name or part
thereof, you can save time by using the search bar.

Finalisation assistant

f] Optimisation assistant active

" Fractal grain is active

When you are applying new post-processing effects, check to see if
the optimising assistant is active. If it is, please remember that
effects will act differently, and sometimes more extreme. When
constructing or enhancing a preset, it is best to turn it off. (Button
above the tone mapping).
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4 Post-processing filter (97/97)

E - E E

Histogram balance
Light tu

detail strengthener

berrati

ur channels

n - luminance HD

channel gradation (

adation

Manual whit:

Overview of Post-Processing effects in HDR projects 5 professional

16 new Post-Processing effects

Dissolving Restoring highlights

Mist & Fog reduction Structure optimization

Denoising optimisation logarithmic  colour  channel -
gradation

Colour dynamic Correcting the shade of colour

Film grain - analogue Warp

Film grain - fractal Flare

logarithmic gradation Lens reflection

Adjusting the focus Water reflection
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> ¢)Select effects

Effects you have selected (0/3)

Have you found an effect that
. B . Tone mapping contrast
you would like to try out? m B we —
Simply double click on it in the
post-processing effect list.

The effect will now be shown in the block below called “Effects you
have selected".

The block of selected effects is the heart of the tone mapping and
post-processing area. It includes all of the post-processing effects
and the settings for each individual effect.

The filters in the example are automatically applied one after the
other to the HDR image and lead to the result tone mapping image.

To temporarily deactivate an effect, simply click on the box beside
the effect's name and remove the checkmark.

Double clicking on an effect removes it from the list.

Effects can be sorted at will by dragging and dropping them up or
down the list.

Tip: The order of the effects within the list can have a substantial
effect on the resulting image. It's worth playing with!

Activate the 360° panorama mode in the bottom left box to prepare
your images for a perfect panorama stitching. The images will be
optimised, so that no borders can be seen when the panorama is
assembled.

The context menu for the effects you have selected has numerous
functions that allow you to activate, deactivate, move or duplicated
effects.
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> d) Settings for selected effects

Settings for the selected effects can be found directly below the
block for the effects you have selected. The parameters for the
currently selected effects will always be shown here.

The available settings and options change depending on the effect
you click on. There are sliders, gradation and mask curves, colours
and pipettes etc. Alternatively, a numerical value can be entered into
the box above the slider.

In the example, we see the parameters for “Colour Balance”, which
consists of three controls for balance: cyan-red, magenta-green and
yellow-blue. Sliding the controls instantly adjusts the image. The
adjustments will be immediately portrayed in the result image. You
will also see a colour flow within the controls, which will give you a
direct indication of how the new value will affect the photo.

Adjusting the cyan-red and yellow-blue values creates a
significantly warmer feeling for the image.
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» Example Mask Curves

This curve regulates the intensity of
the effect for particular bright areas
of the image.

When you pull a point downwards,
pixels with this brightness will be
impacted less by this specific effect,
and vice versa.

Here as well you will find on the top
right hand side a choice box with
presettings. For example the setting
“bright lights” has been chosen.

For the gradation curve in this
example, it means that the lights in

Balance local contrast

- «
e normal v 100% o

EE R Q
p b Radius 100 px high

Strength 35 % <rong

Custom

the picture will be brightened, and the dark roots will exempted in
order to create a striking contrast. This is how mask curves give you
the opportunity to selectively influence images.

During the editing, the preview behind the mask curve immediately
shows the effect's intensity from black (no effect) to white (full

effect).
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» Layer Processing Methods

These features determine the way that an applied
effect appears on a layer. Effects can thus be
enhanced or reduced, and looks can even be
completely changed, which opens up a plethora
of opportunities to play with. To apply processing
methods, click on the drop down menu beginning
with “Normal”.

So that you don't have to try out every single

effect, we have a layer mode browser

With just one click, you have an overview of all of
the processing methods and can comfortably
choose which method fits the effect best. Give it a
try! The effects that you can generate with layer
processing methods are astounding!
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» Selective Editing

For every single one of the 81 post-processing effects it is possible to
apply the selected effect to only a certain area.

Furthermore, specified areas of an image can be influenced at
different intensities by different effects.

The selective editing can be controlled in the parameter area of each
effect and you can open the accompanying window with the button
at the far left.

At the bottom of this window there are three blocks with six, three
and two buttons.

The example clearly shows that the “Colour Intensity” effect has
only been applied to the selected section. Since the edge
definition is only set to 95%, this area is almost rectangular.
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6 Block: add, remove, duplicate, flip and delete the selected areas

3 Block: various display modes for the resulting intensity of the
effect

2 Block: choice of selected surfaces, very practical if the specified
areas are very small or overlapping

You can add up to 32 amplifying (positive) or reducing (negative)
areas for the current effect. The size and position can be determined
directly in the image, optionally in the corners or on the sides of the
area.

The roundness of the rectangle as well as the sharpness and severity
of the selected area can be adjusted with the three controls at the
top of the window.

The result will always be instantly displayed upon releasing the
mouse button.

> Selective editing - gradient module

You can choose from every post-processing effect in the area of
selective editing a course (gradient) of 56 premade models with a
single click.

To activate the desired post-processing effect from your chosen
effects, click in the underlying parameter area on the gradient-
slider.
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A window will open with different types of gradients. From there
choose with a left click your desired type of gradient.

Tip: When you choose a gradient model the selected areas (that are
possibly already part of the current chosen effect present) will be
copied into the clipboard. The selected areas can be brought back
via the insertion of the slider.

» Overview of Certain Keyboard Shortcuts
Cursor Buttons: move the current, active, selected area

Ctrl/Alt + Cursor: fast movement of the current, active, selected
area

1,2,3: switch the display mode
Delete: deletes the current, active, selected area

Esc: closes the window
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Upon closing the window, the chosen effect will only be applied to
the selected area and displayed in the middle of the screen.

You can transfer other effects to the selected area with the “Copy”
and “Paste” buttons , without having to retrace the selection again.

This button deletes all selected areas of the active filter, of course
with a confirmation prompt first.
=X

» Custom Presets

One thing is certain, regardless of which settings you have changed,
if you have applied additional filters or adjusted a filter's settings, the
selected preset has been modified and to the right of the preview
image is the following symbol:

Clicking wiII reset the preset [RECTSEEIEANEETS
back to its initial state. Careful: All
of the modifications applied up to
this point will be undone!

Clicking saves all of the
changes in a new preset. A dialog
box will open where you can enter
a new name for your preset or
confirm the suggested one. The system will name it “Copy”.

2 il
Y| Copy default setting .&Iﬂ

Cancel
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The preset will be saved and moved to the “Custom" presets
category. The new preset has been additionally generated and the
starting preset is preserved. You can also never overwrite a default

preset!

Let's switch now to the “Custom" preset category.

Here we can find our first custom preset.

There are a few new symbols to the right of the preview image:

Is this the favourite preset that
you have made? Mark it to find it
right away next timel

Have you changed this preset
and don't want to lose this new
look? Then create a new one!

Reset the most recently
changed settings for the newest
preset

You have readjusted once
again? No problem. Save the

changes with the disk symbol

4
Change the preset's name

-
===~
Import Export

-no filter -

Custom powerful colours (Copy)

= You can also delete your custom preset entirely.
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Use this to enter a search filter. Import @ Export
For example, enter the search
filter “swampy lake", and
subsequently type the term into
the search filter bar directly
under “Import". All presets with
this search filter will be
displayed.

-no filter -

Natural powerful colou

You can enter the names of places you've holidayed and all of the
presets that you used for those specific holiday photos will then be
easy to find and to apply to other pictures.

The filter drop down menu to the right already contains “swampy
lake", and you can simply select it from the entered search filters.
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10.HDR Generation and Bracketing Editing

What happens in actual HDR image generation in HDR projects 5
professional, before post-processing has made the image printable
and suitable for display on monitors?

In a bracketing series, every individual image area contains a various
number of pixels that are either under or over exposed. Let's
assume that every section of the photo is correctly exposed in at
least one of the images in the series.

HDR projects 5 professional uses a complex process to correctly
filter out all of the accurately lit pixels and assemble them into one
complete image. The process is determined by mathematical
commands - the algorithms. Various algorithms influence different
HDR results, which depend on the final brightness of the series of
images.

The software professionally takes over this process for us. We simply
have to attend to the result and decide which outcome is most
visually pleasing to us and which HDR image we would like to edit
further.

» HDR-Weighting

From post-processing in HDR projects 5 professional, transfer to
HDR generation with this button. We see the work area on the left
hand side for HDR weighting, and HDR algorithms on the right. Your
HDR picture will always be displayed in the middle of the screen
while editing. At the moment the image doesn’t look all that
spectacular, but remember that the monitor cannot yet properly
show what was actually calculated.
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The checkbox at the top left allows you to exclude or
activate an image from the series for the HDR processing. If
you remove a bright picture from the series, the HDR image
will be darker in the midtones in certain areas and vice
versa.

Directly  below is the
miniature view of the single
bracketing exposure. Left
click to display the image at
full size. Another left click on
the mini-picture will return
the HDR final image.

To the right of the colour view is the HDR weighting matrix
for the particular image of the series. Bright pixels indicate
that this area will have a significant influence on the
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resulting HDR image. Dark pixels indicate that this shot will
have little influence on the final HDR photo.

The minus button- under the weighting colour removes
an image from the loaded bracketing series. It is only
possible to delete exposures that are above or below the
master image. The [T =——

master image itself
cannot be removed

and has no minus
symbol.

The button to the left under the bracketing at
preview image selects a new master image. You
will clearly see a significant difference in the brightness
distribution of the HDR fusion.

» Synthetic Bracketing

With help from this exceptional technique, gaps in bracketing series
can be filled.

Let's suppose, and this is no individual case, that the longest
exposure of a series came out somewhat blurry. Click to remove the
image from the series and let the system generate a synthetic bright
image for you. All of the shots in the series are already sharp.

This technique can also be used for manufacturing an HDR image
out of a single picture. Two synthetic exposures will be generated for
an uploaded single image, one with reduced exposure time and one
with increased exposure time.
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An additional image will be synthesised when only two bracketing
images are uploaded so that there are always at least three photos
available in a bracketing series.

synthetic image

Click on and add another synthetic image to the
series. The original image will always be used as the master image.
New images will be labelled as “Synthetic”.

g8 4 synthetic

> Global weight & Exposure value (EV)

For every exposure in bracketing series, synthetic or real, there are
two controls that are very influential on the HDR process:

* Global weight
* Exposure value (EV)

‘% DSC_9483.PG ¥ DSC_94833pPG

The example shows the master image directly after being loaded.
The weighting and exposure controls are in the middle.
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The window to the right of the preview shows how the image is
represented in the HDR fusion. Sliding the global weight to the right,
raising it, increases the proportion of this image in the final HDR
fusion. This can also be recognised through a brighter weighting
matrix. Here “Bright” does not mean that the image will become
brighter, rather that the shot will compose a greater portion of the
HDR fusion. The result can become brighter or darker.

The picture will become brighter once you adjust the exposure
control underneath towards “Bright”. This adjustment can be applied
to each image in the bracketing series and therefore have a
substantial impact on the HDR fusion.

Simply try it out! If need be you can set the controls any time back to
its original setting.

> Global Weight

Above the actual bracketing series are the presets for global weight
called HDR weight default settings.

You can choose an automatic setting for global weight from seven
algorithms with these presets:
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HDR weight default settings

User

1 Equal
Luminance
Congruence
Luminance/congruence
Master dominant
Luminance dominant
Shadow dominant

Equal: all of the weight will be set to the middle position, and every
exposure of the bracketing will be equally represented

Luminance: sets all global weight to an average brightness
(luminance) that corresponds to each respective image in the series

Congruence: sets all global weight to a value corresponding to the
average amount the bracketing images cover the master image

Luminance/congruence: sets all global weight to a value
corresponding to the average brightness in relationship to the
average coverage by the bracketing images

Master dominant: generates an HDR fusion where greater
significance is attributed to the master image

Luminance dominant: all brighter images from the bracketing
series are more significant in the HDR fusion

Shadow dominant: all darker images are weighted more than
brighter ones

Pro Tip: Choosing a congruence setting can, for some bracketing,
lead to less ghost images.
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> Right side ,editing bracketing series”

HOR algorithms.

a. HDR-fusion profile

HDR fusion profile is the ideal opportunity to
save the settings of HDR-fusion on a
bracketing series for later use.

HDR fusion profile

No specific profile v B n

import Export

Following functions of the HDR fusion profile
are at your disposal:

Entropy HOR smoothing

v' Choice of a profile from the list by
clicking on it

v' Saving the current settings as profile

v' Deleting the current profile

v" Import/Export of profiles

Which settings are saved in a HDR fusion
profile?

Generally in a profile all the data of HDR
fusion setting are saved:

v The settings of all the HDR-
algorithms

v The automatic motif brilliance

v" The ghosting correction setting

v" The contrast edge definition optimisation
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Tip: As soon as you have saved at least 1 HDR fusion profile, you will
find the choice of profiles automatically in the post-processing
module as well. With this you will able to take different profiles with
ease and compare them with the finished image.

b. HDR/Ultra HDR

New Ultra HDR technology for fusing bracketing series: Ultra HDR
processes up to 30 intermediate images between two photos with
64-bit precision. The result speaks for itself, and clearly shows a
more detailed picture, especially in difficult situations, for example
when shooting directly against the light. See chapter 9 “Post-
processing: Finalisation” for examples. These settings can be
accessed in post-processing at any time.

Scenario Daylight

Scenario

HDR fusions can also be influenced by different scenarios. If you
would like to adjust your result to a certain lighting, select one of the
following seven scenarios: “Daylight”, “Landscape”, “Twilight",
“Architecture”, “Interior”, “Night-time" and “Mixed light". The scenario
option has an overview of all of the possibilities that can be directly
applied with just one click.

c. HDR-Algorithms

The HDR algorithms can be found together with the setting controls
at the right side of the user interface.

HDR algorithms are mathematical procedures that determine the
weight of individual images from a bracketing series pixel for pixel.
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(See HDR Weight) Every algorithm affects the final HDR result
differently and, depending on the motif, more or less intensely

Overview of HDR Algorithms

HDR projects 5 professional offers 13 different HDR algorithms to
choose from. Click on the algorithm browser for a quick overview.
Here you can choose your preferred settings.

Average: The average is the easiest form of HDR generation and
uses the bracketing midtones.

Entropy: In information theory, entropy is a measure of the density
of information. When applied to an HDR fusion, the appropriate
algorithm measures the density of information of each of the
bracketing images pixel for pixel and converts this weight into the
HDR generation. The result is a very stable process that is set as a
standard algorithm for HDR projects 5.

Luminance Distance: Luminance distance applies the average
brightness distance in the image as the weighting for the HDR
fusion. This algorithm is also a universally applicable process that
can be used for almost every bracketing series.

Colourmix: The colour mix process applies the colour proportions of
the pixels as a weighting measurement. It is particularly suitable for
bracketing series with limited brightness differences in certain areas,
for example fog, smoke or cloud shots.

Luminance Entropy: The luminance entropy is a combination of the
Luminance Distance and Entropy processes.

Luminance RGB: The RGB process combines the Luminance
Distance and Colourmix processes into a new procedure which is
best suited to landscape shots
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Linear Luminance: The linear luminance applies the luminance as
the weighting for the pixels.

Logarithmical Luminance: This algorithm works with logarithmic
brightness (luminance). This corresponds to the human eye's
perception of brightness, which makes this algorithm appropriate
for most bracketing series.

Quadratic Luminance: This algorithm works with the fourth power
of brightness and is thus well suited to editing bright bracketing
series.

Chroma: This algorithm calculates the weighting from the colours of
the individual images and is best suited to bracketing series with
high colour contrast.

Absolute Distance: A very powerful HDR fusion technique, which
combines two essential features. When HDR Smoothing is
deactivated, all HDR images are free of halos and brightness outlines
are avoided.

Luminance Sharpness: For this algorithm, the luminance sharpness
(brightness) is determined for each pixel and converted into a
weighting. This process yields the best detail for HDR fusions.

Colour Sharpness: The colour sharpness process, like the luminance
sharpness feature, determines the sharpness, that is, the level of
detail, for every pixel. This technique uses each colour channel, and
is thus best suited for bracketing series with intense colours.

New algorithms:

Repro neutral: This HDR-process is specially optimised for
bracketing series of scanned photo data with a normal light
situations.
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Repro intensive: The Repro intensive HDR-process is built for
scanned images with low quality. For example images from old Dia-
scans. The fusion of images is here clearly carried out even more
intensive.

Which algorithm should | choose? If you are not sure which
algorithm would be best suited to your subject, use the “Absolute
Distance”. This one is always a good choice. Otherwise, you can
always access and adjust the HDR algorithms and post-
processing/tone mapping at any time.

d. HDR Smoothing for Selected Algorithms: Just below the
selection list for HDR algorithms is a block with controls for
fine-tuning colour sharpness: “Entropy HDR smoothing"

from sharp to very soft.

Entropy HDR smoothing
soft

custom

| sharp
i
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Further parameters for the adjustments of HDR algorithms:

Average

Denoising: Denoising appears directly S8

on the HDR image and the noise [N
removal intensity is also presented as a  [EREEES
percent. A value of 0% means that no
noise pixel will be removed, and a
higher value removes more noise from
the HDR image, which would be

favoured for sharpening an image.

Repro intense

HDR Smoothing: HDR smoothing [ ="
directly influences the weighting
matrixes that were created by the HDR
algorithms. The smoothing intensity is
displayed as a percentage, indicating
how dependent the result is on the
image resolution. A value of 50% means
that weighting matrixes will be smoothed by 50% of the image
resolution. The smoothing works with the GauB’schen scrim
diffuser.

Night/Daytime: The day and night controls match the HDR
algorithms to day or night shots. Move the control to the left for
night, when your bracketing series is suited to a night image, and to
the right for day, when your bracketing series is suited to a photo
taken during the day. You can also just as easily switch the setting to
quickly change the picture’s mood.

For some HDR algorithms there is an additional feature available, in
this example the “Luminance Distance”.
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Halo Adjustment: The halo
adjustment deals with a typical
HDR generation problem: the
formation of halo effect (HDR
shadows). The image on the left
has a minor defect, there are
halos where the roof meets the
sky. In the right-hand image, the
halos were reduced by 85%, so
that the halo effect around the
roof has disappeared.

Luminance distance HDR smoothing

soft

Luminance distance

The halo control is available for certain HDR algorithms, here
the “Luminance Entropy” algorithm was used.

e. Subject-briliance: Activate the automatic intelligent

optimisation by

Subject-brilliance

clicking on the box.
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f. Ghosting correction
(Interactive, automatic optimisation of ghosting correction)

In the area of ghosting correction  [FE e saeTp—
the automatic optimisation will
start through clicking on the
“automatic optimisation” button.

¥ Detail prediction  Lifeforms

Directly on screen you will be to
see the optimisation process.
Here different parameters for 360-degree panorama mode

the detail prognosis as well as

for the intensity are tested by the program until the best
combination is found. This combination will then be inserted into the
program for you.

This calculation can take several seconds, depending on the size of
your bracketing series.

In the result you will get a HDR-image without ghosting and which
through automatic optimisation now includes the maximum possible
amount of details.
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Tip:

When you adjust the focus of the ghosting correction, you will be
able to start the automatic optimisation anew and to receive a new
result that is optimal for the new focus.

g. Contrast range

(HDR-contrast range and automatic optimisation)

The contrast range of a HDR image is made up of the division
between the brightest area of a photo for example a photo directly
in the sun and the darkest area so in the shade areas of the image.

Contrast range

A calculation example:

The brightest area of an image has a value
of 5 (the value 1 would mean a white pixel
in the image) and the darkest area in the
HDR image has a value of 0.01.
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If one divides now 5 by 0.01 then the resulting contrast rage of
5/0.01 = 500. This means that the proportion between the brightest
to the darkest area of the image is 500 to 1.

From this contrast range you can take inspiration from the area
“contrast range”.

The compression value shows how strong the compression of the
HDR image brightness is in comparison to a non-manipulated HDR
image. Here it is 0%, since we haven't done any changes yet.

The compression value you can adjust as you wish to. A low value
creates a higher contrast range in the HDR image (the HDR is being
“stretched” in its brightness). A higher value creates a smaller
contrast range (the HDR is being “compressed” in its brightness).

Underneath the controller you will find three buttons, which control
the automatic optimisation of the contrast range:

v' High-contrast: Creates a high-contrast HDR image.
Therefore an image with very deep shadows and very bright
lights.

v' Optimal: Creates a well-balanced HDR image.

v Compressed: Creates a HDR image with a small contrast
range. This can be helpful with contrast rich bracketing
series, since it helps to bring out further details in tone

mapping.
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As soon as you confirm the automatic modus you will be able to
follow live, how the best values for your current HDR image is
searched for.

Tip:

This value is for every HDR algorithm different. So it could be a good
idea after the change of a HDR algorithm to click on the desired
automatic.

Under the automatic optimisation buttons you will find a curve
display. This shows how much the brightness values of the HDR
image have been adapted in the contrast range optimisation of the
program.

Curve display of the distribution of the brightness value:

High-contrast Optimal Compressed
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In the above example we see how the same HDR image with the
optimisation “high-contrast“(above image) and the other with the
optimisation “compressed” (bottom image) are handled.
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11.Local Adjustments and Selective Drawing

Local adjustment

elective drawing

The selective highlight tool from HDR projects 5 professional
deserves very special attention. Firstly, this tool selectively edits
chosen areas without complicated masks done by hand, like other
photo editing programs. HDR projects 5 professional includes a
completely newly developed intelligent border recognition algorithm
that independently identifies borders, lines, differentiations and light
differences in drawing mode. The boundaries of the area that the
mouse skimmed over are saved as a mask. These easily and
precisely set masks serve as

the basis for seven important Show original image
image enhancements:
“Shading", “Illluminating”,

“Intensifying Colour”, “Reduce
Colour”, “Strengthen Details”,
“Reduce Details” and
“Sharpen”. A mask can even
be saved as its own image file
and used in other photo
editing programs.

Sharpen

How it all works is probably easiest to explain with an example.
Open the selective drawing window (post-processing, finalise -
bottom right). Our example is a single image file of a typical twilight
on the beach. The picture’s colour details are already well edited.
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Now we want to slightly brighten the rocks without taking away the
evening mood; the sky, water and beach should not be brightened.

1. Select editing objective

For this case, select “llluminating”. Make sure that the selected mask
function is activated and the green checkmark is showing.

Masks

= Show original image

/
2. Activate drawing mode

3. Activate filling mode 2
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4. Run the mouse over the contours without clicking. You can
decide and correct the brush size afterwards.

5. Now look at the mask display. The object where the borders
were automatically recognised is now depicted. Click and
hold, and then trace your mouse along the edges of your
chosen object until it is completely selected. In the blink of

an eye we will see the effect as well as the overlying mask.

6. Once fully selected, blend the mask out by moving the mask
intensity control to the left.
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7. You will now see only the effect that is brighter rocks - our
objective was “llluminating”. Now you can adjust the
intensity of the effect by sliding the control towards the + or
-, according to your preferred strength. Done: the rocks are
brighter while the sky, beach and water remain untouched
by the editing.

8. Click on “Close”. You will be returned to post-processing and

the selective change will be applied.

The rocks on the right are significantly brighter after the selective
correction. The sky and sea still have the same tone values as before.

the selective drawing. Our selective mask has remained.

-3
Click on and copy the mask to the clipboard. Switch the

[
mask to “Sharpen” and use the to paste the mask back
again. Now you have sharpened just the rocks, and the

other parts of the image were not influenced
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10.

11.

Every selectively applied effect can be activated and
deactivated with the green checkmarks.

Borders have different intensities in every image. Presets
normally do just fine, but sometimes it is necessary to
adjust the contour and sharpness settings in order to reach
perfect fine-tuned results.

Softness 50 9%

12.

13.

Have you drawn outside of the lines, despite the border

recognition? You can easily remove it with the eraser. n
If you only want to remove a small section, use the eraser
with limitation. When set to 50%, you can only remove 50%
of the mask, regardless of how much you erase. The limited
drawing mode works in the same way, and only draws at a
certain opacity.

If you want to mask the entire image except for a small
object, it is a good idea to mask only the small object and

then reverse the mask by clicking on the EI

Pro Tip: You have two filling modes to choose from when you want
to fill a mask. When do you use which mask? We used the normal fill

A, . L
mode &%  as in our example for a large surface, which is also
preferred for water and sky areas.
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Ray filling mode is very precise and favoured for smaller objects,
geometric forms or subjects with straight lines, like in our example
here.

With ray filling mode you can mask just the walls of the
skyscraper while the window surfaces are not selected.

New in HDR projects 5 professional:

» Optional mask colours

Choose for the presentation of the mask as well as the brush one of
the ready-made colours.

The display will be immediately adjusted to your desired colour.
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» Selektives Zeichnen - Maske erzeugen

Masken kdénnen wahlweise auch aus einem Farbton oder einer
Helligkeit erzeugt werden.

Selective Drawing - Creating Masks

Masks can also be created from a colour or brightness.

e # & C

With the button (1) you activate the “Create Mask” modus. You will
find yourself in the standard mode “Create Mask out of Colour”(2). If
you want to create the mask out of a brightness, chose the (3)
button.

The tolerance controller decides, how sharp (smaller value) or soft
(higher value) the created mask will be.

While you are in the “create mask” mode your mouse pointer will
turn into a pipette. The colour or brightness in which your mouse
pointer is set, will determine the type of mask being created.
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In the above example we can see how a red mask has been created
for the sky.

Tip:
If you want to combine several colours in one mask, simply click on

the desired colours after each other with the pipette on the screen.
The current colour will with every click be added to the current mask.

> Selective Drawing - Smoothing Brush

The smoothing brush (1) gives you the opportunity to draw selective
areas of the mask softly.

To draw an area even softer, just go over the same area with the
smoothing brush several times.
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» Global Mask Functions

In the area of global mask functions are several special modes that
one can use directly.

Masks
o

Show original image

Intensity
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1. Reducing the entire mask outline

becomes

2. Increasing the entire mask outline

becomes

3. Soft-focus effect on the entire mask

A
A
A

becomes

With global functions there are two buttons - the left button fulfils
the function with a lower effect while the one on the right with a
bigger effect.
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> Toreset the function of a mask

Every mask can without any influence on the other masks be reset to
its original state. You simply click on the waste paper button.

Masks

Fxll

u Show original image hs

o Intensity n

After clicking on the button a security query will follow, so that no
important work can be lost by accident.

> Adaptation of automatic masks onto the
“Distortioncorrection” of the RAW module

Selective drawing works directly with the RAW module. This includes
the “Distortioncorrection” that is part of the RAW module and that is
applied completely automatically on several drawn masks.
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In the example we have an image, where the sky has already been
masked.

When we now subsequently correct in the RAW module the horizon
within the image, then the drawn mask will automatically adjust itself
to the “Distortioncorrection”.
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12.Composing-Modus

Masks

In the Composing modus of selective
drawing you have the opportunity to
build up to 4 levels of images into your
current motif.

To switch into the composing modus,
click on the “composing” button (1).

From the list of choices (2) you can
choose with which composing level you
want to work with.

With the button (3) you activate the
currently chosen mask. Now you can
through a click on the frame of the
image (4) upload any image you wish to
create the next level.

You can use RAW images, Jpg, Tiff as
well as several other image formats.

Underneath the display screen you will
find the parameter area that begins
with two buttons with the following
functions:
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(5) Multiple application

Reduce the size of the image on a different level than the one that
youre currently working on. With this option you will be able to
stretch the reduced image outwards (up, down, left, right).

(6) Determine the width-to-height ratio

This function allows you to determine the width-to-height ratio of
the uploaded levels, since the width-to-height ratio in an uploaded
image level can differentiate from the current image you’re working
on. This preserves the proportion of the levels.

(7) The Control-parameter

Width-to-height ratio: If the width-to-height ratio isn”t fixed with
the button (6), you will be able to change the width-to-height ratio
however you desire.

Zoom: Choose the size of that image level by zooming in or out
Shifting horizontally: Move the image level to the left or right
Shifting vertically: Move the image of that level up or down.

Exposure to light: Regularly the light from your current image does
not match with the exposure of your other image levels. Here you
can adapt the exposure and darken or brighten the images however
you want, so that they match.
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A night image with a not very fascinating night sky...

....you can change within a minute with the help of composing
into an eyecatcher.
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13.Edit Weighting with HDR Painter

HDR painter is a powerful tool to manually adjust certain areas by
editing individual images of a bracketing series

Exposure Bracketing View (left): The individual images of a series
are sorted into red, green and blue. When the bracketing has more
than 3 exposures, the master image will be set as green and the next
active neighbouring images as red and blue. If you would now like to
make changes to the weighting of a particular image, pay attention
to the image’s colour and choose the respective colour in the paint
symbol bar.
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To clarify: The brush does not mean that you paint colours goes onto
the image, rather that you can adjust the brightness weighting in
certain areas of individual images. For example, an HDR result shows
a landscape where the exposure is correct everywhere, except the
tree in the foreground is too dark. Here you can select the brightest
image from the series and enhance the brightness of the tree by
“painting” on the object. The final fusion is a balanced image with a
correctly lit tree in the foreground.

Adjusted Weighting: After drawing, the adjusted weighting can be
seen to the right of the
individual image. The white
drawn strokes mean that
you have emphasised the
tree in the brightest image
and that the tree will be
brighter in the HDR result. Global weight 100

Exposure value (EV) 0
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The tree was selectively brightened, without touching the brightness
of the sky, clouds or plains. The diffused brush makes the transitions
invisible. The result is a properly weighted image with a correctly lit
tree in the foreground. The well structured sky remains in the
background.

» Important tools of the HDR-Painter:

enhance the weighting of this
portion of the image.

Increase weighting Draw on the selected area to
>
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Reduce weighting Draw on the selected area to
5 reduce the weighting of this

portion of the image.

Brush size Adjust the size of the brush.

Brush form With numerous new brushes, you

will find the right form for your

selected area.

ﬂ Stamp The stamping mode not only edits
the weighting of the current image,
but adjusts the weighting of all of
the other exposures accordingly.
For example, if you use the paint
tool to increase the weighting of
an area in one image, the
weighting of that same section will
be reduced in all of the other
exposures to amplify the effect.

¥ Blurring If you want soft transitions

i between corrected and original
areas, trace the blurring function
over the borders to soften the
transitions.
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HDR-image/weighting This function mixes the view
between the HDR image and the
weighting. This is very effective for
maintaining control while
drawing.

Delete weighting Delete the drawn weighting
for the active image of the series.

Delete all Warning: This function deletes all of the
drawn weightings and returns to
the initial settings.

#
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14.Ghosting Removal with HDR Painter

When we manually adjust parts of images, it naturally has an effect
on the program’s ghost image correction. Ghosting can occur when
capturing a bracketing series of a scene where people or vehicles are
in motion and thus captured at a different position in every shot.
Without the automatic ghosting removal from HDR projects 5
professional, the moving objects would appear at a different
position in every image, thus causing a ghost-like effect.

Manually removing ghosting:

The following example illustrates how HDR painter can eliminate the
regular problem of people walking through a bracketing series.

Here is the example after being uploaded and without ghost
removal:

Looking at the image, the people on the left and right are
immediately recognisable as ghost images.
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Let's remove the ghosting as follows:

1. Find the image in the series displayed on the left that comes
closest to the brightness of the HDR image. This is usually the master
image or one above/below.

2. Select the button for the appropriate colour for this photo, and
HDR projects 5 professional will allocate red to this image and
automatically open the HDR drawing mode.

3. Select the “Increase Weighting” function and activate stamping
mode.

4. Draw over the people by carefully dabbing with the brush.

5. Select the “Blurring” button and stamping mode.
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6. Carefully trace the edges of the correction with the blurring brush.
Donel!

Switch to tone mapping and select the “Natural sharp” preset to see
the result.

The ghosting has disappeared from the HDR image!
Tip: “Dabbing” the brush is the optimal method for best results.

If you would like the program to automatically remove ghosting or
you have simply forgotten to activate the ghosting removal in the

HDR preparation when loading the images, click on this button u
to start a new evaluation.

Warning! A new evaluation eliminates all manually removed
ghosting!
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15.Workflow

> Edit final image further in an external program

HDR projects 5 professional offers interaction with external
programs. That way you can take a successful HDR result to another
photo editing program and continue there.

» Open in other projects programs

Click on the “Projects” symbol in the toolbar to open the image in a
different program from the projects series. Use the drop-down
menu beside the symbol to choose one of the programs that you
already have installed on your computer.

PROJECTS

» Open in other photo-editing programs

To directly open the image in another photo editing program, such
as Adobe Photoshop, click on the corresponding button in the
symbol bar.

If necessary, go through the 2 ED B IEI
settings to show the path to .
the program. Click on “Extras”
in the menu and select 2. Adobe Photoshop™
“Settings” in the drop-down
menu:

External image processing

Adobe Lightroom™

~  Adobe Photoshop Elements™
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Extras Add-ons Information

Batch processing (HDR + tonemapping) Ctrl+B
Batch processing (HDR fusion)

HDR preparation

Benchmark

Settings Ctrl+P

Create restore point Shift+Z

Timeline Ctrl+T

Next, click on the “Export” tab. You can enter the name of a photo
editing program here, and save it for later as well.

Externc.

E St TIFF 16-Bit (*.tiff)

-> File name_HDR projects.tiff

» Work with a timeline and restore points

This option can be found in the symbol bar at the top edge of the
screen:

“Create Restore Point” saves an in-between point of the current
settings. You can now always return to this stage of your editing.
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You can save as many editing restore points as you like. The timeline
displays the restore points and makes it possible to call up any
phase with just a single click:

This function is especially useful when, for example, you are satisfied
with an image, yet want to continue trying out different settings and
effects. Simply set a restore point and carry on editing your picture.

—
If you want to go back, simply click on your restore point in the
timeline.
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16.Selecting and Saving Sections of E

Images
To save a final image, click on the button in the toolbar, go through
the file menu or use the corresponding keyboard shortcut (Ctrl+S).

> Cropping and captions

As soon as you have initiated to save a file, the cropping and caption
window will open.

At the top are several practical aids for perfect image composition
and cropping.

You can set the aspect ratio and activate guidelines like the rule of
thirds, the golden section or the golden spiral. Practical is also the
new photo centre display that you can obtain by simply clicking on
this button.
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The centre of the window shows your final image. Fix the area to be
saved by adjusting the corners and borders of the photo.

At the bottom is an option to enter a caption. You can determine the
size, position and background for the text. The size of the text will be
automatically coordinated to the final cropping.

You can either crop free-
handedly or use one of the 71
provided formats.

Please note: If you choose the
cropping, e.g. 13 x 18, the final
image will not be saved as 13 x
18 cm, rather as a ratio of 13 to
18.

¢ Maintain original ratio

As soon as the image has been cropped and captioned, confirm the
save and the following window will prompt you to select a file format

and name your file.
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17.RAW-Processing

You can upload and edit RAW image data with the integrated RAW
mode. Numerous tools are available to you here, such as
denoising/sharpen, exposure, colour and detail as well as powerful
distortion capabilities.

In this RAW mode changes that are made will be transferred onto
the entire bracketing series, so that you only have to put in the
settings once.

Resetting the category:

Every category can through a click on the reset-button (bottom left)
be reset to its original state without influencing the settings of the
other categories.

White balance

Colour

o7
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An overview of the most important RAW functions:

White balance:

Here you can regulate the colour temperature. Use the pipette to
select a white balancing colour directly from the image.

Denoising/sharpness:

This feature regulates the image's noise and sharpness. Control the
quality and different types of noise such as colour noise, banding or
hot pixels.

Colour balance/white balance:

Here it's all about colour and black/white correction. Modify the
general colour mood and neutralise white and black - the icing on
the cake for professional colour correction.
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Exposure:

Influence lights, shadows, contrast and brightness in the final image.
With the new dynamic brightness you can adapt the light to the
contents of each image individually.

Detail:

Fine-tune clarity and micro-details with lights, shadows and
midtones.

Colour:

These colour settings are all about the luminosity of lights and
shadows. You can even reduce the presence of unwanted chromatic
aberrations.

New is differentiating chromatic aberrations by colours:
Green light diffraction

Blue light diffraction

Red light diffraction

These light diffraction corrections allows you to purposefully remove
the chromatic aberrations of a certain colour.

Thereby a lens curve will be calculated backwards on top of the
colour channel.

Palate:

Adjust the saturation of individual colours.
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Distortion:

Take a closer look. These mighty tools can straighten out the
horizon, correct camera angles and lens errors. Use “Autofit” to
automatically trim any awkward borders.

The reference grid can be adapted in the distance between the grids
as well as in its transparency. This is how you will always have the
maximum overview when you are correcting your settings.

Distortion

This category includes a several new
special effects like a mist & fog
correction, save highlights, sepia and
film grains as well as different
gradients.

Pro Tip.

When you take a landscape shot,
shift the controller to “Gradient top”
to a dark tone and create in that way
a neutral thick (ND) - process filter.
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General:

Activate the “360° panorama mode” to optimise matching edges of
images in a panorama series.

Save your settings as a camera profile to save time in the future. This
can be reset at any time.

If you have conducted the settings in RAW mode, click on “apply”.

If you save your settings in the camera profile, you will save a lot of
time for future photographs. The settings can be reversed at any
time.

i

you like to save the settings in the current camera profile?
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18.Batch processing
HDR projects 5 professional's batch processing allows for
automatic processing of multiple bracketing series. The function can
be found in the drop-down menu for “Extras” in the menu bar. Here
you will find two types of batch processing:

a.) Batch processing HDR + tone mapping

b.) Batch processing HDR fusion

» a. Batch processing HDR + tone mapping

First, choose the source folder where the individual images (HDR
from one exposure) and/or the bracketing series are located. The
files can also be mixed, since the system will automatically recognise
and sort the bracketing series vs single shots.

The “Include all subdirectories” checkbox not only searches through
all of the selected folders, but also all subfolders and their further
subfolders.

New: Batch processing: Renaming and sorting

In the area of the target folder you will be able to activate the “sort
mode”. You set thereby the batch processing in the renaming and
sort mode.

Source file Results
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As soon as the sortation mode is active, new push buttons will
appear.

File name filter:

Here you can insert a file name for renaming the image with the help
of Syntax:

-Text

##.# for the number of bracketing series, the number of # signs
gives the number of places of numbering

-Text

#4#.# for the number of images within the current bracketing series,
the number of # signs shows the lists the number of places that are
numbered.

The file name “Shooting072016_####_##" creates image data in the
form of:

Shooting072016_0001_01.cr2, Shooting072016_0001_02.cr2, .. ,
Shooting072016_0002_01.cr2, Shooting072016_0002_01.cr2, ...

Note: To sort your image data into the data carrier without
renaming, leave the file name simply empty.

Deleting the original file

This option you should only use if you are absolutely sure that your
insertions are correct.
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The original data of the image will then be deleted. Only the newly
changed sortation and names will remain, the original data of the
image will then have been deleted.

Install a subdirectory per sequence:

Results

File filter

Processing settings

Exposure bracketin

% wHBM2012_0877_8_9_CR2

v g s

When this function is active, every bracketing series gets its own
subdirectory.
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Note: Remember that looking through folders with several
subfolders can require a lot of time. That's why selecting “C:\" is not
recommended.

> Allocation and automatic bracketing recognition

This feature takes on all of the work for you. Now you can choose
between different modes:

Automatic allocation: Loads all of the images and based on the
images’ content, locates those that belong to an exposure bracketing
series. The brightness as well as the coverage are compared, which
results in very good automatic recognition.

Individual images: The “Individual images” option sorts every image
into its own bracketing series. This setting is very well suited for
editing image sequences, for example, those generated from
footage.

2 image to 9 image groupings: Select this option if you have taken
HDR films or are certain that the bracketing series in your folder all
contain the same number of shots. The file names for the final
images will automatically be successive, so that the edited images
can be directly used in a video editing program.

Results: Here you can set where the resulting images of the batch
processing will be saved. Select the corresponding folder with the
“Target directory (. . .)* button or enter the name of the folder
directly into the text box.

Format: You can choose from nine different formats to save your
resulting images. With .jpg, .tif and .png, there are two 8-bit formats
(LDR) and four 16-bit formats (HDR). JPG images are always the
highest quality and TIF files are saved uncompressed and without
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defects. For further web editing, the final images can be saved in
Open EXR as well as in Portable Floatmap and Radiance RGBE.

g: Natus
Natural balanced

¥ Berlin2014_006:
L]

/4 Bremerhaven2013_0369_70__ 73_CR2

DSC_3761_2_3_4_5_6_7_IPG

i &EER

7 HBM2012_0877_8_9_CR2
. |

1MG_0092_3_4_5_6_7_CR2
- -

> Processing settings

Select the settings for the HDR preparation and tone mapping here.
These apply to all of the bracketing series in the batch processing.
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HDR default settings: The HDR default settings offer three to four
presets for every HDR algorithm. Simply select your preferred preset
from the list.

Post-processing: The presets contain all post-processing/tone
mapping presets, including all of the presets from your “Custom”
category that you designed yourself. You can also choose a special
preset before batch processing and apply it to multiple bracketing
series. As soon as the HDR presets and post-processing switch, all of
the preview images in the bracketing series will be recomputed, so
that you always see a real view of the results.

HDR preparation: Open this dialog to adjust options like colour
space, white balance, alignment etc.

Note: Apple computers systematically open this dialog before the
batch processing window.

Exposure bracketing view: Here you will find information about the
located bracketing exposure series.

Exposure bracketin

¥ Bremerhaven2013_0369_70___73_CR2

At the top of the display is the number of listed bracketing series.
Directly below it are three buttons for global activation and
deactivation of series.
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Activate all exposure bracketing: Activate all corresponding
bracketing series for the calculation. (Standard setting)

Deactivate all exposure bracketing: Deactivates all assigned
exposure bracketing for the calculation.

Remove single images: Removes all exposure bracketing for single
images from the calculation and display. You can use this option if
the program develops a very bright or very dark image incorrectly, or
if you have taken photos that should not be processed by HDR.

> Batch processing for HDR fusion

In HDR  fusion batch
processing, you calculate the
image stacks for the pure
fusion HDR images without
applying any post-processing
or tone mapping filters.

These methods make the
most sense when you want to
edit the fused results further
in other programs or want to
create and save pure 32-bit
HDR formats.

The available lossless final formats:
- Radiance RGBE (.hdr)

- Open EXR (.exr)

- Tiff 32-bit (.tif32)

- Portable Floatmap 32-bit (.pfm)
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19.Via GPS coordinates directly to
OpenStreetMaps

New: If the GPS coordinates are in your Exif-files (Menu -> Exif
information), then you will be able to locate the place where the
photo was shot when you click on the button “Open GPS coordinates
via Browser”. You will see the place the photo was shot in

www.OpenStreetMaps.org.



http://www.openstreetmaps.org/

20.Add-ons
With help from add-ons, you can not only import presets from HDR
projects 5, but also entire post-processing modules can be
integrated, which can be necessary to create new preset looks. If you
have bought one or several add-on-packets in our shop, install the
add-ons like this:

1. Extract the files from the downloaded zip folder:
PresetCollection-HDR-projects-Lostplaces.zip

2. Open your HDR projects 5 version
3. Click on Menu -> Add-ons -> Import Add-ons
Add-ons
*-+ Import add-on

*-_ Remove add-on

@ Add-on information

4. Select HDR projects LostPlaces (18) in the following dialog
window, open it with a double-click and select the
HDR_lostplaces.praddon. Then click "Open".

5. The add-on will now be imported. A confirmation message will
appear:

6. Please close and restart the program to be able to use the add-on
with all of the other presets.

7. Open HDR projects 5 professional and load an image or a
bracketing series. Switch to post-processing mode (palate symbol). If
you are the owner of HDR projects 5 professional,
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you will automatically be sent to post-processing mode. Select Menu
-> Add-ons -> Addons Information, and confirm that your filter
package was successfully activated.

>> Default settings <<

8. Filter selection can be
found on the left-hand All: 155
side, directly under the
import/export buttons.

Here only the new,
recently imported
presets are
displayed.

Import Export

9. C(lick the arrow to open the dropdown menu and select
"Lost Places". Now exclusively the new presets will appear
on the left display box.

10. If you would prefer to
not filter the presets,

>> Default settings <<

the new presets can be ”:;:r;fi

found in the Landsca

"Architecture” category. i

The "Lost Places" % Favourites: 4
presets have "LP" in -B O+
their names to be easily Import @ Export
recognisable. 1o filter -

118



21.Plug-In Installation
HDR projects 5 professional can also be used as a plug-in for
Adobe® Photoshop. Newer versions of Photoshop are automatically
detected by HDR projects 5 professional during installation and the
plug-ins are installed in the respective plug-in folder. Older versions
of Photoshop might require manual installation.

If you purchased your software as a download or if you have lost
your CD, the plug-ins are also available for download at:

www.projects-software.com/plugins

> Adobe Photoshop & Adobe Photoshop Elements

The following window will appear when installing HDR projects 5
professional:

Select the version of | =~ —
Select Components 2 4
Photosho P where Which components shouid be installed?
you wou Id like to Select the components you want o install cear the components you do not want o
X install. Click Next when you are ready to continue.
install  the HDR ,
{Full installation v
projects 5 THDR projects 5 professional (64-8it) 46,3 M8
7] Photoshop CS6 Plugin (64-5it) 0,2M8
i _ [¥] Photosh lugin (32-6it) ;
professional plug | ‘omcemie
. . " " [¥] Lightroom Plugin 0,1MB
n. Cl IC k on next 7] Grgaphlcs cardi support 0,1MB
and follow the
n St ru Ctl ons fro m Current selection requires at least 47,6 MB of disk space.
the installation
. [ <Back ][ next> | [ cancel
assistant. The plug-

ins will then be automatically installed.

You can conduct the installation of the Plug-In at a later point as well.
Please install Photoshop before the project Plug-ins!
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After the installation of the Plug-Ins, you can open Photoshop again.

In Photoshop you will find under menu item “Filter” the entry
Franzis. Here you will find all of the Plug-Ins listed.

Click on HDR projects 5 professional. The image that you have
opened and edited in Photoshop will now be opened in HDR 5
professional.

Now you will find the program in Photoshop Filter-Plugin mode. You
will be able to edit the image as you re used to in HDR projects 5
professional.

Fle Edit Image Layer Type
Ctrl+F

. -~ Unconstrained x

Convert for Smart Filters
Untitled-1 @ 100% (Layer 0, RGB/8) * x

Filter Gallery...
Adaptive Wide Angle... - Shift+Ctrl+a
Lens Correction... Shife+Cri+R
Liquify... Shift+Ctri4+x
Oil Paint...

Yanishing Point... Ale+Cerl+y

The Plugin Site
AKVIS

Athentech Imaging
Auto FX Software

BLACK WHITE projects 5...
COLOR projects 5...
Nik Collection DENOISE ocoly eofeccion
Redfield HDR projects 5 professional...
Topaz Labs + Mg
Filter online durchsuchen... SHARPEN projects professional...

The Plugin See
AXVES

Athentech imaging
Auto FX Software
Cut Out

]  6LCK WHTE pojects ..

Imagencomic * COLOR projects 5..
Nk Collection ’ DENOISE peojects pecfessional..
Redfield [ HUR progects 5 peodensional
Topaz Labs » HOR progects 5.

ARP! 5 |
Filter onbme durchauchen. SHARPEN proyacts predessiona
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When youre finished editing the image you can send the image
directly back to Photoshop by clicking on the button “apply”.

With the button “discard” you finish the filter Plug-in, without
sending the changes that you have done to the image back to the
Photoshop level. The editing that you have done in HDR projects 5
professional will be discarded.

The project program will then automatically close itself. This
mechanism is conducted by Adobe Photoshop and cannot be
stopped.
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» Using photoshop plug-ins with Mac OS X
Adobe Photoshop & Adobe Photoshop Elements

3 » MAZ 1OR progects § professnal OF EN IR
o o o
— -

[y e— [T yemm—
> P

Plug-ins can be found on the start screen in the “Plug-ins” folder.
Select the appropriate folder for your version of Photoshop (we
chose Photoshop CS6 for our example). Double click the .zip file to
extract the plug-ins.

Next, drag & drop the plug-in HDRProjectsProFilter_PH6.plugin
(PH7 with other Photoshop versions) to the plug-in folder for your
version of Photoshop, which is normally labelled as “plug-ins”.

Start up your version of Photoshop, load an image and navigate to
“Menu -> File -> Export-> HDR projects 5 professional”.
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@ Photoshop File Edit Image Layer Type Select ELG@ View Window
Mosaic ®F

Auto-Select: Group + Show Transform Controls

Convert for Smart Filters
x Screen Shot 2014-10-18 at 4.50.33 PM.png @ 100% (Lay,
. S x -

] b Filter Gallery...
s Adaptive Wide Angle... X O0%A
= Camera Raw Filter... 0BA
W, Lens Correction... ©%R
P Liquify.... 08X
G Oil Paint...
i Vanishing Point... RV
*
s Blur >
r'd Distort >
¥4 Noise > B
28 Franzis » BLACK WHITE projects 5...
:/A iE COLOR projects 5...
A Filter online durchsuchen.

One click will start the plug-in. With a click you start the Plug-In. The
image will now be opened in HDR projects 5 professional.

Now you will find the program in Photoshop Filter-Plugin mode. You
will be able to edit the image as you re used to in HDR projects 5
professional.

When you’re finished editing the image you can send the image
directly back to Photoshop by clicking on the button “apply”.

With the button “discard” you finish the filter Plug-in, without
sending the changes that you have done to the image back to the
Photoshop level. The editing that you have done in HDR projects 5
professional will be discarded.
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The project program will then automatically close itself. This

mechanism is conducted by Adobe Photoshop and cannot be
stopped.

» Adobe Lightroom plug-ins with Windows
B s oo S =<l

Select Components I
Which components should be installed? [iei}

Select the components you want to install; dear the components you do not want to
install. Click Next when you are ready to continue.

[Fullinstallation -

HDR projects 5 professional (64-Bit) 46,3M8
Photoshop CS6 Plugin (64-Bit) 0,2MB
Photoshop CS6 Plugin (32-Bit) 0,2MB

' Lightroom Plugin 0,1MB '

Current selection requires at least 47,6 MB of disk space.

[ < Back ][ Next > ][ Cancel ]

Start the installation program and check in the component selection
if “Lightroom Plugin” has been chosen. Copy the plug-in folder
“Lightroom Plug-in” from your CD-ROM.

If you have no CD, the plug-in is also available for download at:
www.projects-software.com/plugins
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Subsequently open your Lightroom version. Start Lightroom and
navigate to “File->Plug-In (zusatzmodul) manager” to check if the
plug-in has been activated.

B vgreoom

File | Edit Library Photo Metadata View Window Help

New Catalog...
Open Catalog... Ctrl+0
Open Recent »
Optimize Catalog...
Import Photos and Video... Ctrl+Shift+1
Import from Another Catalog...
Import a Photoshop Elements Catalog...
Tethered Capture »
Auto Import »
Export... Ctrl+Shift+E
Export with Previous Ctrl+Alt+Shift+E
Export with Preset »
Export as Catalog...
Email Photo...
Plug-in Manager... Ctrl+Alt+Shift+,

v
Show Quick Collection Ctrl+B
Save Quick Collection... Ctrl+Alt+B
Clear Quick Collection Ctrl+Shift+B
Set Quick Collection as Target Ctrl+Shift+Alt+B
Library Filters »
Printer... Ctrl+P
Page Setup... Ctrl+Shift+P
Exit Ctrl+Q
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n .
| Lightroom Plug-in Man:

Lightroom Plug-in Manager

project.. |2
e BLACK WHITE proj e ¥ Status
Path: C:\Use
e Canon Tether Plugin
stalled and Show
e COLOR projects 5 Version: 1.1.2.2
B : = Status: This pl
Facebook
o Flickr » Plug-in Author
HDR projects 4
O s - i
HDR projects 5
T
0 HDR projects 5 profes...
Instalied and running
Leica Tether Plugin
e talled and g E |
Adobe Add-ons...

LR: HDR projects 5 professional: Installed and executed

Mark a bracketing series in your lightroom library. Right-click on the
image directly in Lightroom and select ,Export -> Export to HDR
projects 5 professional®”.
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Export...
Export with Previous

Burn Full-Sized JPEGs

Exportto DNG
Open in Loupe For Email
Open in Survey For Email (Hard Drive)

BLACK WHITE projects 5
Lock to Second Window ;

Export to BLACK WHITE projects 5
Show in Explorer OLOR projects $
Goto Folder in Library Export 10 COLOR projects’5
Goto Collection » SR
Set Flag ’ Export to HOR projects &
Set Rating » DR projects 5
Set Color Label » Export to HOR projects 5
J Shorteut Keyword
Export to HOR projects 5 professional

Add to Quick Collection
Stacking 4 Export to NEAT projects professional
Create Virtual Copies ekt
s Pty 5 Export to PURE HOR projects

SHARPEN proje
HamsLR e Export to SHARPEN projects
Rotate Right (CW)

pro
Export to SHARPEN projects professional

Remove Photos...

View Options...

Or: Choose “File -> Export with Preset -> Export to HDR projects 5
professional”.

New Catalog.

Open Catalog o
Open Recent .
Optimize Catalog..
Import Photas and Video. Cute 1
Import from Ancther Catalog,
Importa Phatoshop Elements Catalog..
Tethered Capture .
Acta lmport .
Bxpott. Cuteshireg
| > T
Bum Ful-Sized JEGs
Email Phetes.. Eymiivong
ForEmail
Plug-in Manager Clrle Al Shite FoeEmal (Hard Dvve)
Plugin Extrss , v
Show Quick Collection Cutd Export to BLACK WHITE projects 5
Save Quick Collection CuteaR+B R project
Clear Quick Collecion CuteshifteB Expart to COLOR projects 5
o HOR projects
Library Fiters , O L
Printer Cutep Eport o HOR projects 5
Page Setup.. Culeshitt-p .
B cutq | Boortto HOR projects S proessions
Exportto NEAT projects professionsl
PURE HOR project
Export to PURE HOR projects
HARDEN project
Export to SHARPEN projects
Export to SHARPEN projects professional
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» Adobe Lightroom Plug-Ins with Mac OS X

The Plug-In for Adobe Lightroom will not be automatically installed
with MAC OS X. To integrate it into Lightroom, continue as follows:

Install HDR projects 5 professional to the program link of your Mac.

Copy the plug-in .zip file from the “Lightroom Plug-in" folder on your
CD-ROM. Double click on the .zip file to extract the plug-in to a folder
where you want it to be located.

We recommend the folder where also your presets are stored:

“Benutzer(Users)/username/HDR Projects 5 Pro".

n} n = = Lightroom Plugin 0

B Downioads Allas

22 Dropbox

HDRProjects5Pro.Irplugin

M Documents

£ Akvis

Heute, 14:22
Heute, 14:22
Heute, 14:22

B hiehmann-pc

HOR Projects 2
2 MacDan 8 HOR Projects 3

Start Lightroom und navigate to “File ->Plug-In Manager”.

Click the “Add"” button in the Lightroom Plug-In Manager.
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L] Lightroom Piug-in Manager

Lightroom Plug-in Manager

Aperture/iPhoto Importer v status

/HDR ProjectsPro.irplugin
Behance

Canon Tether Plugin Versior

Status: This plug-in Is enat

Facebook

Fickr » Plug-in Author Tools
Leica Tether Plugin

HDRprojects Sprofessional

Nikon Tether Plugin

SHARPEN projects

Add Remove

Adobe Add-ons.

Disable

Nodiagnostic messages

Choose the relevant Lightroom-Plug-ln of HDR projects 5
professional that you have just copied to your computer, by

navigating towards it.

If the Plug-in is not instantly marked with a green active dot, close

Lightroom and start it again.

Now the Plug-In should be installed and be up and running.

You have now several options to get your image from Lightroom to

HDR projects 5 professional.

“File-> export with file-> export to HDR projects 5 professional”.

OR:

Right-click on the image directly in Lightroom and select ,Export ->

Export to HDR projects 5 professional”.
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Lock to Second Window

Show in Finder
Go to Folder in Library
Go to Collection

Set Flag

Set Rating

Set Color Label

Add Shortcut Keywo:

Stacking
Create Virtual Copy

Metadata Presets
Transform

Metadata
Export

Email Photo

Add to Quick Collection and Next
Remove Photo...

View Options...

Background Options

3«

b0 L sl I, 2

Export...
Export with Previous

Lightroom Presets
Burn Full-Sized JPEGs
Export to DNG
For Email (Hard Drive)
For Email
Lightroom-Vorgaben
For Email (Hard Drive)
For Email
Burn Full-Sized JPEGs
Export to DNG
HDR projects professional
Export to HDR projects 5professional
SHARPEN projects
Export to SHARPEN projects
User Presets
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22.Keyboard Shortcuts

Overview of the integrated Keyboard shortcuts

In the main menu in the area of /nformation you will find an
overview of all available keyboard shortcuts. Click on this item to
open the overview.

In the overview you will be able to scroll through the different areas,
where you can take shortcuts.

To have constant access to the overview via a separate window, you
can use the function ,open in browser‘(window bottom left), which
will show the list in a standard browser.

You will also be able to print the keyboard shortcuts from there.
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23.Supported RAW formats
In the main menu in the area information you will find an
integrated list of supporting camera RAW-formats sorted by
manufacturer.

In the top area of the window you will find a selection of choices,
with which you will be able to filter the list for singular camera
manufacturers. This way you will find your camera faster.
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To have constant access to the supporting camera RAW- formats via
a separate window, you can use the function ,open in
browser“(window bottom left), which will show the list in a standard
browser.

You will also be able to print the supporting RAW-formats from
there.

Photo credit:

Imagery provided by the members of the FRANZIS projects team and
the programmers.

Special thanks to Mr. Falko Sieker for providing several exposure
bracketing series and single images for testing purposes. The
majority of the screen shots found in this user manual are results of
Mr. Sieker's bracketings.
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Support

If you have questions regarding the installation, problems or errors of the
software, please contact the FRANZIS customer support team.

Contact form: https://www.projects-software.com/

Please understand that your questions can only be answered directly by
FRANZIS customer support. This is to give us the opportunity to constantly
enhance our customer service for you and to make sure that you receive only
the most qualified answers to all of your questions as fast as possible.

This is how our customer support works best:

Please have the most important details about your computer and about our
product at hand when you call our customer support. These include:

. Name of the product

. Product ISBN (which you can find on the back of the packaging,
above the easy to spot barcode).

. Operating system of your computer

. Technical details of your PC including all your peripheral devices
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Copyright

Franzis Verlag GmbH has prepared this product with the greatest possible
care. Please read the following conditions:

All the programs, routines, controls, etc., contained in this data media or
within this download are protected by their respective authors or distributors
as mentioned in the respective programs. The purchaser of this data media
or of this download is authorised to use those programs, data or data groups
that are not marked as shareware or public domain for his/her own purposes
within the provisions of their designated use. He/she is authorised to use
programs or parts of programs that are marked as shareware, freeware or
public domain within the restrictions given by the respective programs or
parts of programs. A reproduction of programs with the intent of distributing
data media containing programs is forbidden. Franzis Verlag GmbH holds the
copyright for the selection, arrangement and disposition of the programs and
data on these data media or these downloads.

The data and the programs in this data media or within this download have
been checked with the greatest possible care. Considering the large quantity
of data and programs, Franzis assumes no warranty for the correctness of
the data and a flawless functioning of the programs. Franzis Verlag GmbH
and the respective distributors do not undertake neither warranty nor legal
responsibility for the use of individual files and information with respect to
their economic viability or their fault-free operation for a particular purpose.

Additionally, there is no guarantee that all the included data, programs, icons,
sounds and other files are free to use. Therefore the publisher cannot be
held liable for a possible breach of third party copyrights or other rights.

Most product designations of hard- and software and company names and
labels mentioned in this product are registered trademarks and should be
treated as such. The product designations used by the publisher are basically
as the manufacturer describes them.

© 2016 Franzis Verlag GmbH, Richard-Reitzner-Allee 2, 85540 Haar, Mlnchen
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